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Introduction
Welcome to Workflow, an important component of Microsoft Dynamics™ GP. You 
can use the Workflow system to create approval processes for:

• Purchase orders
• Sales quotes
• Customer credit limit overrides
• General Ledger batches
• Payables Management batches
• Receivables Management batches

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Access Help in Microsoft Dynamics GP
• Access Help on the Workflow web site
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Workflow, and how it integrates with Microsoft Dynamics GP.

The manual is divided into the following parts:

• Part 1, Getting started, provides an overview of the Workflow system and 
explains how it is deployed in your organization’s network.

• Part 2, Workflow basics, explains some key concepts and terms you’ll need to 
understand to set up and maintain the Workflow system.

• Part 3, Setup, explains how to set up the Workflow system and create 
individual workflows.

• Part 4, Maintenance and troubleshooting, contains maintenance procedures, 
such as modifying a workflow, viewing document history, and deactivating the 
Workflow system.

• Part 5, Reports, describes the Workflow reports you can generate. These reports 
help you monitor the Workflow system and identify specific workflow steps or 
approvers who may be slowing down an approval process. 
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Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Access Help in Microsoft Dynamics GP

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the web. The following resources are 
available from the Help menu.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites 
tab. Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently 
displayed, type the name of the window, and click Display.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as clicking 
items on a menu or a toolbar or clicking buttons in a window. 
This example directs you to go to the File menu and click 
Print.

Bold Bold type indicates the names of fields, tabs, menus, 
commands, and buttons, and text you should type.
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About This Window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. To change the 
way required fields are highlighted, click Microsoft Dynamics GP menu > Tools > 
Setup > User Preferences > Display, and specify a different color and type style.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a web page that provides links to a variety of web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Access Help on the Workflow web site

When the Workflow system is installed, a Workflow web site is created. This web 
site is built on Microsoft Office SharePoint® Server and can be accessed with 
Microsoft Internet Explorer®. 

When you click the Help icon on a Workflow web page, the relevant help topic for 
that page is displayed. You can use the search field on the help page to search for 
information. You also can click the Home icon button to browse the contents of the 
Help.
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I N T R O D U C T I O N

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.
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Part 1: Getting started
This part of the documentation provides an overview of the Workflow system and 
explains how it is deployed in your organization’s network.

• Chapter 1, “Workflow overview,” explains what the Workflow system is and 
describes the benefits it provides.

• Chapter 2, “Workflow architecture,” describes the components of the Workflow 
system and explains how these components work together. Deployment 
diagrams are also included.
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Chapter 1: Workflow overview
The following information provides a basic overview of the Workflow system and 
describes the benefits it provides.

• What is workflow?
• Benefits of using the Workflow system
• How users will interact with the Workflow system

What is workflow?

This documentation defines the term workflow in two ways:

1. Workflow is a system
Workflow is the system that you installed with Microsoft Dynamics GP. The 
Workflow system provides functionality you can use to create individual workflows, 
or approval processes.

2. Workflow is an approval process
A workflow is the approval process for a document or batch. A workflow defines 
how a document or batch “flows” through the system by showing who must 
approve it, and the conditions under which they must approve it.

For example, consider the following illustration of a purchase order approval 
workflow. This workflow shows who must approve purchase orders, and the 
conditions under which their approval is required. For example, suppose Sam 
submits a purchase order for $2,000. In this scenario, the purchase order must be 
approved by Frank. If Sam submits a purchase order for $8,000, it must be approved 
by both Frank and Sue.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.
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Benefits of using the Workflow system

There are several benefits of using the Workflow system in your organization. Here 
are a few key benefits.

Consistent processes
The Workflow system enables you to define the approval process for specific 
documents and batches, such as purchase order documents and Receivables 
Management batches. By using the Workflow system, you ensure that documents 
and batches are reviewed and approved in a consistent and efficient manner.

Automatic notification
Users can be automatically notified when a document or batch is assigned to them 
for approval, or when a document or batch they submitted is approved. Users can 
be notified via desktop alerts or e-mail alerts. For more information about alerts, see 
Indicate if you want to send alert messages on page 64.

Access through Office SharePoint Server and Outlook
Users don’t have to log on to Microsoft Dynamics GP to approve documents and 
batches. Users can approve documents and batches by accessing the Workflow web 
site, which is built on Microsoft Office SharePoint Server 2007, or by responding to 
e-mail messages in Microsoft Office Outlook® 2007.

Reports
There are several Workflow reports you can generate. These reports help you 
monitor the Workflow system and identify specific workflow steps or approvers 
who may be slowing down an approval process. For more information about each 
type of Workflow report, see Part 5, Reports.
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How users will interact with the Workflow system

Users can interact with the Workflow system through Microsoft Dynamics GP, 
Office SharePoint Server, and Outlook.

Microsoft Dynamics GP
Workflow functionality is available in many areas of Microsoft Dynamics GP. For 
example, the Purchase Order Entry window enables a user to submit purchase 
orders for approval. This window has a message bar and history pane. The message 
bar displays the document’s status and has buttons for approving and rejecting the 
document. The history pane displays previous actions made to the document.

Office SharePoint Server
When the Workflow system is installed, a Workflow web site is created. This web 
site is built on Office SharePoint Server and can be accessed with Microsoft Internet 
Explorer. Workflow administrators and managers can use this web site to set up the 
Workflow system, create individual workflows, and generate reports. Users can use 
this web site to approve documents and batches that are assigned to them.

History pane

Message bar

Workflow web site
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Outlook
When a document or batch is assigned to a user for approval, an e-mail message can 
be sent to the user. The e-mail message displays information about the document or 
batch and has an Edit this Task button. When the user clicks this button, a window 
appears where the user can approve or reject the document or batch.

Click Edit this Task to
approve or reject the

document or batch.
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Chapter 2: Workflow architecture
The Workflow system is made up of several software components. The following 
information describes these components and shows where they may be installed on 
your network.

• Architecture overview
• Deployment configurations

Architecture overview

The Microsoft Dynamics Workflow system accesses two different types of data. It 
accesses accounting data from your Microsoft Dynamics GP databases, such as 
purchase orders, sales quotes, and batch information. It also accesses workflow 
setup information from your Office SharePoint Server databases, such as the names 
of approvers and the conditions under which they must approve a document or 
batch.

The following diagram illustrates the Workflow architecture and shows the 
software components that are used to access data.

Microsoft Dynamics GP

client

Outlook

client

Internet Explorer

client

Workflow

web service

Workflow

web site

Workflow

server components

Web Services for 

Microsoft Dynamics GP

Microsoft Dynamics GP

data

Clients

Microsoft Dynamics 

Workflow

Office SharePoint Server 

data

Windows Workflow Foundation

Office SharePoint Server
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As the diagram shows, the Microsoft Dynamics Workflow system consists of three 
main pieces: a web service, a web site, and server components. The Workflow web 
service enables employees using Microsoft Dynamics GP clients to interact with the 
Workflow server components. The Workflow web site enables employees using 
Outlook and Internet Explorer to interact with the Workflow server components.

The Workflow server components contain business logic and communicate with the 
SharePoint and Microsoft Dynamics GP databases. These components are installed 
on a server running Office SharePoint Server and can communicate directly with 
the SharePoint databases. The components must use Web Services for Microsoft 
Dynamics GP to communicate with the back office databases.

Deployment configurations

There are several ways the Workflow system can be deployed. The following 
information describes the supported deployment configurations and shows where 
each software component is installed.

It’s important that you know and understand how the Workflow system is 
deployed in your organization so that you can perform maintenance procedures 
and help troubleshoot any issues that may arise.

For more information about how the Workflow system is deployed, see the 
Workflow Installation Guide.

Single-server configuration
In a single-server configuration, all the server-side components (such as Microsoft 
Dynamics GP, Web Services for Microsoft Dynamics GP, Office SharePoint Server, 
and Workflow) are installed on one server.

This configuration is recommended for testing and demonstration purposes only. This 
configuration does not provide the best security or performance.

Back Office Server

· Microsoft SQL Server™

· Microsoft Dynamics GP

· Web Services for Microsoft 

Dynamics GP

· Office SharePoint Server

· Workflow

Employee Workstation

· Microsoft Dynamics GP

· Outlook

· Internet Explorer

Employee Workstation

· Outlook

· Internet Explorer
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Separate web server configuration
The separate web server configuration consists of two servers. The back office 
server hosts your Microsoft Dynamics GP and Office SharePoint Server databases. 
The web server hosts Web Services for Microsoft Dynamics GP, Office SharePoint 
Server, and Workflow.

This configuration provides better security and performance than the single-server 
configuration.

Web Server

Web Services for Microsoft

Dynamics GP

Office SharePoint Server

Workflow

Employee Workstation

Microsoft Dynamics GP

Outlook

Internet Explorer

Employee Workstation

Outlook

Internet Explorer

Back Office Server

SQL Server

Microsoft Dynamics GP

Office SharePoint Server

databases
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Multiple web server configuration
The multiple web server configuration consists of one back office server and two or 
more web servers. The back office server hosts your Microsoft Dynamics GP and 
Office SharePoint Server databases. The web servers host Web Services for 
Microsoft Dynamics GP, Office SharePoint Server, and Workflow.

Of the three configurations described in this section, the multiple web server 
configuration provides the best security and performance.

Web Server

Web Services for Microsoft

Dynamics GP

Employee Workstation

Microsoft Dynamics GP

Outlook

Internet Explorer

Employee Workstation

Outlook

Internet Explorer

Back Office Server

SQL Server

Microsoft Dynamics GP

Office SharePoint Server

databases Web Server

Office SharePoint Server

Workflow

Web Server

Office SharePoint Server

Workflow



P
A

R
T

 2
: W

O
R

K
FLO

W
 B

A
S

IC
S



18 W O R K F L O W  A D M I N I S T R A T O R ’ S  G U I D E

Part 2: Workflow basics
The following information explains some key concepts and terms you’ll need to 
understand to set up and maintain the Workflow system.

• Chapter 3, “Workflow types,” describes the different kinds of workflows you 
can create.

• Chapter 4, “Workflow participants,” helps you understand who is involved in 
the Workflow system.

• Chapter 5, “Workflow security,” describes how security is managed on the 
Workflow web site and in Microsoft Dynamics GP.

• Chapter 6, “Workflow actions,” explains the actions originators and approvers 
can take on a document or batch.

• Chapter 7, “Workflow tasks,” provides an overview of tasks, including 
information about when they are created and how they can be reassigned to 
other users.

• Chapter 8, “Workflow status and priority,” explains the statuses and priorities 
given to documents and batches in the Workflow system.

• Chapter 9, “Workflow examples,” provides examples that show the many ways 
a workflow can be designed and structured.
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Chapter 3: Workflow types
There are six types of workflows you can create. The following information 
describes each type of workflow.

• Purchase order approval
• Sales quote approval
• Customer credit limit override approval
• General Ledger batch approval
• Payables Management batch approval
• Receivables Management batch approval

Purchase order approval

A purchase order approval workflow is used to gain approval for purchase orders 
before they are processed. Users can submit purchase orders for approval in the 
Purchase Order Entry window in Microsoft Dynamics GP.

After purchase orders are approved, you can process them according to your 
company’s business practices. For example, you can print them and receive 
shipments.

Before you can use this workflow, you must clear the Activate Approvals check box in the 
PO Enhancements Setup window (Microsoft Dynamics GP menu > Tools > Setup > 
Purchasing > Purchase Order Enhancements).

Users can submit
purchase orders for

approval in the Purchase
Order Entry window.
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Sales quote approval
A sales quote approval workflow is used to gain approval for sales quotes before 
they are processed. Users can submit sales quotes for approval in the Sales 
Transaction Entry window in Microsoft Dynamics GP.

After sales quotes are approved, you can process them according to your company’s 
business practices. For example, you can transfer them to orders.

Customer credit limit override approval
A customer credit limit override approval workflow is used to gain approval for 
orders, fulfillment orders, and invoices that exceed the set credit limits for 
customers. Users can submit documents that require credit limit override approval 
in the Sales Transaction Entry window in Microsoft Dynamics GP.

After these documents that exceed credit limits are approved, you can process them 
according to your company’s business practices.

Before you can use this workflow, you must remove the password from the Exceed Credit 
Limit field in the Receivables Management Setup window (Microsoft Dynamics GP 
menu > Tools > Setup > Sales > Receivables).

Users can submit sales
quotes for approval in
the Sales Transaction

Entry window.

Users can submit sales
documents that require

credit limit override approval
in the Sales Transaction

Entry window.
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General Ledger batch approval
A General Ledger batch approval workflow is used to gain approval for General 
Ledger batches before they are posted. Users can submit General Ledger batches for 
approval in the Batch Entry window in Microsoft Dynamics GP.

After General Ledger batches are approved, you can post them.

Before you can use this workflow, you must turn off the batch approval feature in Microsoft 
Dynamics GP. To do so, open the Posting Setup window (Microsoft Dynamics GP menu 
> Tools > Setup > Posting > Posting) and select the Financial series. Clear the Require 
Batch Approval check box for the General Entry and Clearing Entry origins.

Payables Management batch approval
A Payables Management batch approval workflow is used to gain approval for 
Payables Management batches before they are posted. Users can submit Payables 
Management batches for approval in the Payables Batch Entry window in Microsoft 
Dynamics GP.

After Payables Management batches are approved, you can post them.

Before you can use this workflow, you must turn off the batch approval feature in Microsoft 
Dynamics GP. To do so, open the Posting Setup window (Microsoft Dynamics GP menu 
> Tools > Setup > Posting > Posting) and select the Purchasing series. Clear the 
Require Batch Approval check box for the Payables Trx Entry, Payment Entry, and 
Computer Checks origins.

Users can submit General
Ledger batches for approval
in the Batch Entry window.

Users can submit Payables
Management batches for
approval in the Payables

Batch Entry window.
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Receivables Management batch approval

A Receivables Management batch approval workflow is used to gain approval for 
Receivables Management batches before they are posted. Users can submit 
Receivables Management batches for approval in the Receivables Batch Entry 
window in Microsoft Dynamics GP.

After Receivables Management batches are approved, you can post them.

Before you can use this workflow, you must turn off the batch approval feature in Microsoft 
Dynamics GP. To do so, open the Posting Setup window (Microsoft Dynamics GP menu 
> Tools > Setup > Posting > Posting) and select the Sales series. Clear the Require 
Batch Approval check box for the Receivables Sales Entry and Receivables Cash 
Receipts origins.

Users can submit
Receivables Management

batches for approval in the
Receivables Batch Entry

window.
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Chapter 4: Workflow participants
The following information explains who the participants are in the Workflow 
system.

• Workflow administrator
• Workflow manager
• Originator
• Approver
• Delegate
• User with read-only access

Workflow administrator

The Workflow administrator is the person who sets up and maintains the Workflow 
system. The Workflow administrator has access to all pages on the Workflow web 
site and can perform all tasks.

By default, the user who installed the Workflow system is automatically given 
Workflow administrator privileges.

If you are a Workflow administrator, you can give other users Workflow 
administrator privileges. To do so, use the following steps to add the users to the 
Microsoft Dynamics Workflow Administrator group in Office SharePoint Server.

1. Go to the Workflow web site.

2. Click Site Actions > Site Settings. The Site Settings page is displayed. 

3. Click People and groups. The People and Groups: All People page is displayed. 

4. Click Groups on the Quick Launch. The People and Groups: All Groups page is 
displayed. 

5. Click the Microsoft Dynamics Workflow Administrator group. The People 
and Groups: Microsoft Dynamics Workflow Administrator page is displayed. 

6. Click New > Add Users. The Add Users: Microsoft Dynamics Workflow page is 
displayed. 

7. Enter the names of the users you want to add to the group.

8. In the Give Permission area of the page, be sure the Add users to a SharePoint 
group option is marked and Microsoft Dynamics Workflow Administrator 
[Full Control, Limited Access] is selected in the list.

9. If you want to send e-mail messages to the users to let them know they’ve been 
added to the group, select the Send welcome e-mail to the new users option.

10. Click OK.

For more information about the Microsoft Dynamics Workflow Administrator 
group, see Chapter 5, “Workflow security.”
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Workflow manager

By default, there are six different types of workflows:

• Purchase order approval
• Sales quote approval
• Customer credit limit override approval
• General Ledger batch approval
• Payables Management batch approval
• Receivables Management batch approval

A workflow manager can create and configure a particular type of workflow. For 
example, suppose you name your purchasing manager, Ann, as the workflow 
manager for the purchase order approval type. This means Ann can create and 
configure purchase order approval workflows. She can also act on (that is, approve 
or reject) any purchase order in the company, regardless of who the purchase order 
is assigned to.

When you set up the Workflow system, you’ll specify a manager for each type of 
workflow. For more information, see Select the workflow types you want to use on 
page 55. 

Each manager is automatically added to the Dynamics GP <Workflow Type> 
WorkflowManager group in Office SharePoint Server. For more information about 
this group, see Chapter 5, “Workflow security.”

Originator

The originator is the person who submits a document or batch for approval. For 
example, in the following workflow illustration, Sam is the purchase order 
originator.

You’ll specify who the originators are when you create and configure a workflow. 
For more information, see Select originators on page 61.

Each originator is automatically added to the Dynamics GP <Workflow Type> 
WorkflowOriginator group in Office SharePoint Server. For more information about 
this group, see Chapter 5, “Workflow security.”

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.
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Approver

The approver is the person responsible for reviewing a document or batch. If the 
approver approves the document or batch, it will move on to the next step in the 
workflow, if necessary. If the approver rejects the document or batch, the workflow 
approval process stops.

In the following workflow illustration, Frank, Sue, and Ann are approvers.

You’ll specify who the approvers are when you create and configure each workflow 
step. For more information, see Select approvers on page 73.

Each approver is automatically added to the Dynamics GP <Workflow Type> 
WorkflowApprover group in Office SharePoint Server. For more information about 
this group, see Chapter 5, “Workflow security.”

Delegate

A delegate is a person who can act on a workflow task on behalf of someone else. For 
example, if an approver will be out of the office for a period of time, the approver 
can delegate his or her tasks to another approver in the workflow.

For example, if Sue will be on vacation for a couple of weeks, she can delegate her 
tasks to Frank or Ann.

Approvers can specify who their tasks should be delegated to on the Workflow User 
Delegation page. For more information, see Delegate tasks on page 80. 

Each delegate is automatically added to the Dynamics GP <Workflow Type> 
WorkflowDelegate group in Office SharePoint Server. For more information about 
this group, see Chapter 5, “Workflow security.”
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User with read-only access

You can give a user who is not involved in a workflow the ability to view 
documents or batches submitted to the Workflow system. A user with read-only 
access can view documents or batches in the Documents area of the Workflow web 
site.

For example, assume your warehouse manager, Ellen, is not part of the purchase 
order approval workflow. However, Ellen needs to view purchase orders so that she 
can prepare for shipments that will be arriving in the warehouse. You can give Ellen 
read-only access to purchase orders submitted to the Workflow system.

You’ll specify who has read-only access when you:

• Configure a workflow. For more information, see Give read-only access on 
page 61.

• Configure a workflow step. For more information, see Specify when to send 
carbon copies on page 75.

Each user will be automatically added to the Dynamics GP <Workflow Type> 
WorkflowCarbonCopies group in Office SharePoint Server. For more information 
about this group, see Chapter 5, “Workflow security.”

A user with read-only access can
view documents or batches in the

Documents area.
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Chapter 5: Workflow security
The following information explains how security is managed on the Workflow web 
site and in Microsoft Dynamics GP.

• Security on the Workflow web site
• Security in Microsoft Dynamics GP

Security on the Workflow web site
Security on the Workflow web site is determined by the Office SharePoint Server 
group you belong to.

The Microsoft Dynamics Workflow Administrator group is the only group you should 
manually assign users to. Users are automatically assigned to the other groups when you 
configure a workflow. For information about how users are added to each Office SharePoint 
Server group, see Chapter 4, “Workflow participants.”

The following table lists the groups that are used with Workflow and the security 
privileges granted to each group.

Each group name is followed by a company ID. For example, if Fabrikam has a company ID 
of 1, purchase order approvers will belong to the Dynamics GP Purchase Order Approval 
WorkflowApprover1 group.

Office SharePoint Server group A user in this group can...

Microsoft Dynamics Workflow Administrator Specify a manager for each type of workflow
Configure the workflow calendar
Create a workflow of any type
View all workflow tasks
Act on any workflow task (regardless of who the task is assigned to)
View all documents and batches
Generate reports about the Workflow system
Configure his or her workflow alert message settings
Delegate his or her workflow tasks

Dynamics GP <Workflow Type> WorkflowManager Create workflows of the specified type
View all tasks associated with the workflow type
Act on any task associated with the workflow type (regardless of who the task 
is assigned to)
View all documents or batches associated with the workflow type
Generate reports that display data associated with the workflow type
Configure his or her workflow alert message settings
Delegate his or her workflow tasks

Dynamics GP <Workflow Type> WorkflowOriginator Submit documents or batches associated with the workflow type
View all tasks associated with the workflow type
View all documents or batches associated with the workflow type
Generate reports that display data associated with the workflow type
Configure his or her workflow alert message settings
Delegate his or her workflow tasks

Dynamics GP <Workflow Type> WorkflowApprover Submit documents or batches associated with the workflow type
View all tasks associated with the workflow type
Act on tasks assigned to him or her
View all documents or batches associated with the workflow type
Generate reports that display data associated with the workflow type
Configure his or her workflow alert message settings
Delegate his or her workflow tasks

Dynamics GP <Workflow Type> WorkflowDelegate

Dynamics GP <Workflow Type> WorkflowCarbonCopies View all documents or batches associated with the workflow type
Configure his or her workflow alert message settings
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Security in Microsoft Dynamics GP

Security in Microsoft Dynamics GP is determined by your Microsoft Dynamics GP 
security role and Office SharePoint Server group.

Microsoft Dynamics GP security role Access to windows, reports, and 
accounting data in Microsoft Dynamics GP is determined by your security role. For 
example, a user assigned to the Purchasing Manager role has access to the Purchase 
Order Entry window.

Office SharePoint Server group The ability to perform a workflow action is 
determined by the Office SharePoint Server group you belong to. Here’s how it 
works:

1. When you choose to perform a workflow action, such as approving or rejecting 
a document, the system will determine what your Microsoft Windows® user 
account is (that is, the user account you entered when logging on to the 
computer). 

2. The system will determine which Office SharePoint Server groups are allowed 
to perform the action. (For a list of actions each group can perform, see Security 
on the Workflow web site on page 27.)

3. Using your Windows user account, the system will determine if you belong to 
the Office SharePoint Server groups that are allowed to perform the action.

For example, assume that your Purchasing Manager, Frank, has logged on to 
Microsoft Dynamics GP. Because Frank is assigned to the Purchasing Manager role, 
he can access the Purchase Order Entry window. Because Frank is also a member of 
the Dynamics GP Purchase Order Approval WorkflowApprover group, he will be 
able to approve or reject the purchase orders assigned to him.

Frank’s security
role gives him

access to the
Purchase Order
Entry window.

Frank’s SharePoint 
group allows him to 
act on purchase 
orders.
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Chapter 6: Workflow actions
A workflow approval process involves two main groups of people: the originators 
and the approvers. For example, in the following purchase order workflow, Sam is 
the originator and Frank, Sue, and Ann are the approvers.

The following sections explain the workflow actions that originators and approvers 
can take on a document or batch.

• Actions an originator can take
• Actions an approver can take
• How an approver can act on a document or batch

Actions an originator can take

The originator starts the workflow approval process by submitting a document or 
batch for approval. The originator does this in Microsoft Dynamics GP. For 
example, to submit a purchase order, the originator will use the Purchase Order 
Entry window. To submit a General Ledger batch, the originator will use the Batch 
Entry window.

These windows have buttons that enable originators to submit the document or 
batch, or save it.
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greater than 

$1,000.
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submits a 

purchase

order.

Sue

Must approve if 
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The originator uses these
buttons to submit the
document or save it.
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Submit for approval
When the originator submits the document or batch for approval, the Workflow 
system evaluates the document or batch and determines if it requires approval. If 
so, the document or batch is assigned to the appropriate approver with a status of 
Pending Approval.

If the Workflow system determines that the document or batch does not require 
approval, the document or batch is given a status of No Approval Needed.

Save for later
When the originator saves the document or batch, any changes made to the 
document or batch are saved. The document or batch is not submitted for approval; 
the originator can submit it at a later time.

Actions an approver can take

When a document or batch is assigned to an approver, the approver can take one of 
the following actions.

The following information applies to workflow steps that have a single approver. If there are 
multiple approvers for a step, see Select approvers on page 73 to understand how the action 
an approver takes affects the workflow approval process.

Approve
When an approver approves a document or batch, the document or batch is 
assigned to the next approver in the workflow, if necessary. If no additional 
approval is required, the document or batch is given the status of Approved and the 
workflow approval process is complete.

For example, suppose Sam submits a purchase order for $6,000. In this scenario, the 
purchase order must be approved by Frank and Sue. When Frank approves the 
purchase order, it is assigned to Sue for approval. When Sue approves the purchase 
order, it is given the status of Approved, and the workflow process is complete.
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Reject
When an approver rejects a document or batch, the document or batch is given the 
status of Rejected and the workflow process is complete.

For example, using the workflow previously shown, suppose that Sam has 
submitted a purchase order for $12,000 and that it is assigned to Sue. When Sue 
rejects the purchase order, it is given the status of Rejected and the workflow 
process is complete.

Sam can resubmit the purchase order, with or without changes. If Sam resubmits the 
purchase order, a new workflow process starts at step 1.

Delegate
When an approver delegates a document or batch, the document or batch is 
assigned to another approver in the workflow.

For example, using the workflow previously shown, suppose that Sam has 
submitted a purchase order for $12,000 and that it is assigned to Frank. Frank then 
delegates the purchase order to Ann.

Ann will then act on behalf of Frank. This means that if Ann approves the purchase 
order, it will be assigned to Sue for approval—just as if Frank had approved it. Once 
Sue approves the purchase order, it moves on to Ann for approval.

In order for an approver to delegate a document or batch, the Allow approver to manually 
assign workflow tasks to someone else check box on the Configure Workflow page must 
be selected. For more information, see Indicate whether approvers can manually delegate 
tasks on page 63.

Request change
When an approver requests a change to a document or batch, the document or batch 
is given the status of Pending Changes and the workflow process is complete. The 
originator, however, can make changes and resubmit the document or batch for 
approval.

For example, using the workflow previously shown, suppose that Sam has 
submitted a purchase order for $12,000 and that it is assigned to Sue. When Sue 
requests a change, the purchase order is given the status of Pending Changes and 
the workflow process is complete.

Sam can resubmit the purchase order, with or without changes. If Sam resubmits the 
purchase order, a new workflow process starts at step 1.
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How an approver can act on a document or batch

An approver can act on a document or batch using Microsoft Dynamics GP, Office 
SharePoint Server, or Outlook.

Microsoft Dynamics GP
In Microsoft Dynamics GP, approvers can act on documents and batches using entry 
windows and lists.

Approvers can use entry windows to act on a specific document or batch. For 
example, an approver can approve a specific purchase order using the Purchase 
Order Entry window.

Approvers can use lists to act on several documents or batches at one time. For 
example, an approver can approve multiple purchase orders at one time using the 
All Purchasing Transactions list.

An approver can act on 
a purchase order using 
the Purchase Order 
Entry window.

By clicking the Approve
option, the selected

documents in the list will
be approved at the same

time.
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Office SharePoint Server
Approvers can use their web browsers to access the Workflow web site, which is 
built on Office SharePoint Server. Using this web site, approvers can view and act 
on the documents and batches assigned to them.

Outlook
When a document or batch is assigned to a user for approval, an e-mail message can 
be sent to the user. The e-mail message displays information about the document or 
batch and has an Edit this Task button. When the user click this button, a window 
appears where the user can approve, reject, delegate, or request a change to the 
document or batch.

The approver can act 
on the document using 
Office SharePoint 
Server.

Click Edit this Task to
approve or reject the

document or batch.
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Chapter 7: Workflow tasks
The following information provides an overview of workflow tasks, including 
information about when they are created and how they can be reassigned to other 
users.

• Task overview
• When tasks are created
• Due dates
• Delegation

Task overview

A task represents a document or batch assigned to a user for approval. For 
information about how users can act on the tasks assigned to them, see Actions an 
approver can take on page 30 and How an approver can act on a document or batch on 
page 32.

When tasks are created

When a user submits a document or batch for approval, the Workflow system 
evaluates the first step in the workflow to determine if approval is required there. If 
the Workflow system determines that approval is required, a task is created for that 
approver.

Simple example
Using the workflow illustrated below, suppose Sam submits a purchase order 
totalling $8,000. The Workflow system evaluates step 1 to determine if the purchase 
order meets the condition specified. In this scenario, the purchase order is more 
than $1,000, so the Workflow system creates a task for Frank.

Assume that Frank approves the purchase order. The Workflow system then 
evaluates step 2 to determine if the purchase order meets the condition specified. 
Because the purchase order is more than $5,000, Sue’s approval is required. The 
Workflow system creates a task for Sue.

After Sue approves the purchase order, the purchase order is given the Approved 
status. The purchase order can now be printed and shipments can be received.
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Complex example
Using the workflow illustrated below, suppose Sam submits a purchase order 
totalling $8,000 for Adventure Works. The Workflow system evaluates step 1 to 
determine if the purchase order meets the condition specified. In this scenario, the 
purchase order is more than $1,000, so the Workflow system creates a task for Frank.

Assume that Frank approves the purchase order. The Workflow system then 
evaluates steps 2a and 2b simultaneously. Because the purchase order is more than 
$5,000 and the vendor is Adventure Works, the Workflow system creates tasks for 
Sue and Bob.

Both Sue and Bob must approve the purchase order before it can move on to Ann. 
This is because step 2a (Sue) and step 2b (Bob) converge at step 3 (Ann). For 
example, assume that Sue approves the purchase order first. The purchase order 
cannot be assigned to Ann until Bob approves it, as well. When Bob approves the 
purchase order, the Workflow system creates a task for Ann.
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Due dates

Each task has a due date. The due date indicates the date by which the approver 
must respond to the task—that is, approve or reject the document or batch the task 
represents.

Default due dates
When you configure a workflow step, you’ll specify how many days the approver 
has to respond to the task. For example, the following workflow shows the number 
of days each approver has to act on assigned tasks.

For more information about setting the default due date for each workflow step, see 
Set a time limit on page 75.

Overriding default due dates
Approvers can override the default due dates. For example, using the previous 
workflow illustration, suppose Sam submits a purchase order for $18,000. When 
Frank approves the purchase order, he can specify how many days Sue will have to 
approve or reject the purchase order. Similarly, when Sue approves the purchase 
order, she can specify how many days Ann will have to approve or reject the 
purchase order.
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When a task is overdue
When an approver fails to act on a task by the task’s due date, the task is considered 
overdue, or escalated. When you configure a workflow, you must specify what 
should happen to overdue tasks. The following options are available.

For more information about how to manage overdue tasks, see Indicate what should 
happen when a task is overdue on page 64.

Delegation

Approvers can delegate, or reassign their tasks to other approvers. For example, if 
Frank will be out of the office for a period of time, he can delegate his tasks to 
another approver in the workflow, such as Sue or Ann.

Tasks can be delegated manually or automatically.

Manually delegating a task  If Frank feels uncomfortable approving a specific 
purchase order, he can manually delegate that purchase order to Sue. For more 
information about manually delegating a task, see Actions an approver can take on 
page 30.

In order for an approver to manually delegate a document or batch, the Allow approver to 
manually assign workflow tasks to someone else check box on the Configure Workflow 
page must be selected. For more information, see Indicate whether approvers can manually 
delegate tasks on page 63.

Automatically delegating tasks If Frank will be out of the office for a couple 
of weeks, he can have all of his tasks automatically delegated to another approver. 
For more information about automatically delegating tasks, see Delegate tasks on 
page 80. 

If you select this 
option

This will happen

Take no action The task will remain assigned to the current approver.

Delegate to next approver The system will automatically assign the task to the next approver 
in the workflow.

Delegate to The system will automatically assign the task to the user you 
specify.

Have system automatically The system will automatically approve or reject the task, 
depending on the action you choose.
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Chapter 8: Workflow status and priority
Each document in the Workflow system has a status and priority. The following 
sections explain the different statuses and priorities.

• Status
• Priority

Status

When you view a document or batch in Microsoft Dynamics GP or on the Workflow 
web site, you’ll notice that it has a workflow status. A document or batch will have 
one of the following statuses.

Status Description

Workflow Not Activated The document or batch was created before a workflow was 
activated (for the specific type of document or batch).

The Workflow Not Activated status applies to documents in the 
work and history tables.

Not Submitted The document or batch has been saved, but not yet submitted for 
approval.

No Approval Needed The document or batch has been submitted for approval, and the 
Workflow system has determined that the document or batch does 
not require approval. The workflow approval process is complete.

Submitted The document or batch has been submitted for approval, but the 
web server—running Office SharePoint Server and the Workflow 
server components—has not responded yet.

The Submitted status may indicate a connectivity problem with the 
web server.

Pending Approval The document or batch is awaiting approval.

Pending Changes An approver has requested that the originator make changes to the 
document or batch and resubmit it. The workflow approval process 
is complete.

Approved The document or batch is approved. The workflow approval process 
is complete.

Rejected The document or batch is rejected. The workflow approval process 
is complete.

Workflow Deactivated The Workflow administrator or manager deactivated the workflow 
this document or batch was using. The workflow approval process 
is complete.
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Priority

When you view a document or batch, you’ll notice that it has a workflow priority 
indicator. The priority indicator reflects the importance of the document or batch. 

The originator sets the priority when submitting the document or batch. Approvers 
can change the priority when they review the document or batch.

Priority Indicator

Low

Normal No indicator

High
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Chapter 9: Workflow examples
There are many ways you can design and structure a workflow. The following 
sections provide examples of workflows and explain how documents and batches 
move through each workflow.

• Simple workflow
• Workflow with multiple first steps
• Workflow with multiple approval paths
• Workflow with converging steps
• Workflow with multiple approvers in a step
• Workflow where an approver is an originator

Simple workflow

The following example illustrates a very basic workflow. This workflow has three 
approvers, and lists the specific conditions under which their approval is required.

To understand how a document moves through this workflow, assume that Sam 
submits a purchase order totalling $7,000. This purchase order must be approved by 
Frank and Sue. Because the purchase order is not greater than $10,000, Ann’s 
approval is not required.

After Sue approves the purchase order, it is given the Approved status. The 
purchase order can now be printed and shipments can be received.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.
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Workflow with multiple first steps

The following example illustrates a workflow with multiple first steps. Based on the 
vendor, the purchase order will go to Frank, Andreas, or Ed.

To understand how a document moves through this workflow, assume that Sam 
submits a purchase order for Northwind Traders totalling $6,000. This purchase 
order must be approved by Ed and Sue. Because the purchase order is not greater 
than $20,000, Ann and Maria are not required to approve it.

After Sue approves the purchase order, it is given the Approved status. The 
purchase order can now be printed and shipments can be received.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Andreas

Must approve if 

the vendor is 

Contoso, Ltd.

1b.

Ed

Must approve if 

the vendor is 

Northwind 

Traders.

1c.

Ann

Must approve if 

greater than 

$20,000.

3.

Maria

Must approve if 

greater than 

$50,000.

4.
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Workflow with multiple approval paths

The following example illustrates a workflow with two approval paths. The 
purpose of the top path (steps 1a and 2a) is to obtain approval for purchase orders 
for Adventure Works, a special vendor. The purpose of the bottom path (steps 1b, 
2b, and 3b) is to obtain approval for purchase orders over specific amounts.

To understand how a document moves through this workflow, assume that Sam 
submits a purchase order for Adventure Works totalling $13,000. This purchase 
order will move through both approval paths simultaneously. In the top approval 
path, the purchase order must be approved by Frank and Andreas. In the bottom 
approval path, the purchase order must be approved by Sue and Jill. The purchase 
order won’t be given the Approved status until all of those people approve it.

Now assume that Sam submits a purchase order for Northwind Traders for $13,000. 
This purchase order will move through the bottom approval path only. The 
purchase order must be approved by Sue and Jill.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

1b.

Andreas

Must ALWAYS 

approve.

2a.

Jill

Must approve if 

greater than 

$10,000.

2b.

John

Must approve if 

greater than 

$20,000.

3b.
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Workflow with converging steps

The following example illustrates a workflow with converging steps. Notice that 
steps 2a and 2b converge at step 3.

To understand how a document moves through this workflow, assume that Sam 
submits a purchase order for Adventure Works totalling $10,000. This purchase 
order is first assigned to Frank. When Frank approves the purchase order, it is then 
assigned to both Sue and Bob.

Both Sue and Bob must approve the purchase order before it can move on to Ann. 
This is because step 2a (Sue) and step 2b (Bob) converge at step 3 (Ann). For 
example, assume that Sue approves the purchase order first. The purchase order 
cannot be assigned to Ann until Bob approves it, as well. When Bob approves the 
purchase order, it can move on to Ann.

After Ann approves the purchase order, it is given the Approved status. The 
purchase order can now be printed and shipments can be received.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2a.

Bob

Must approve if 

the vendor is 

Adventure 

Works.

2b.

Ann

Must ALWAYS 

approve.

3.
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Workflow with multiple approvers in a step

The following workflow example has a step that requires approval from more than 
one person. Notice that Bill, Jo, and Mary are the approvers at step 3.

When you configure a step with multiple approvers, you can specify how many of 
the approvers at that step must approve the document. You can select one of the 
following options.

Take the first response
If you select this option, the action applied to the document or batch is determined 
by the first person who responds.

For example, assume that Sam has submitted a purchase order for $50,000 and it is 
currently at step 3 in the workflow. If Mary is the first person to respond to the 
document, the action she takes is applied to the document. For example, if she 
approves it, the document is sent to Ann for approval. If Mary rejects the document, 
it is given the status of Rejected and the workflow process is complete.

Majority must approve
If you select this option, the majority of the approvers must approve the document 
or batch in order for it to continue down the workflow approval path.

For example, consider the workflow previously illustrated. Assume that Sam has 
submitted a purchase order for $50,000 and it is currently at step 3 in the workflow. 
If two of the three approvers approve the document, it is sent to Ann for approval. If 
two of the three approvers reject the document, it is given the status of Rejected and 
the workflow process is complete.

All must approve
If you select this option, all of the approvers must approve the document or batch in 
order for it to continue down the workflow approval path. 

For example, consider the workflow previously illustrated. Assume that Sam has 
submitted a purchase order for $50,000 and it is currently at step 3 in the workflow. 
If all of the approvers (Bill, Jo, and Mary) approve the document, it is sent to Ann 
for approval. If one person rejects the document, it is given the status of Rejected 
and the workflow process is complete.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Bill, Jo, Mary

Must approve if 

greater than 

$10,000.

3.

Ann

Must approve if 

greater than 

$20,000.

4.
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Workflow where an approver is an originator

Approvers have permission to submit documents or batches for approval. For 
example, Sue, an approver in the purchase order approval workflow, can submit 
purchase orders for approval.

The way in which Sue’s purchase orders are routed through the workflow depends 
on the selections made in the Select originators area of the Configure Workflow 
page on the Workflow web site. 

In the Select originators area, you specify who is allowed to submit documents or 
batches for approval. You can allow any user to submit documents or batches, or 
you can allow only specific users. Regardless of which option you select, approvers 
will always be able to submit documents or batches for approval. However, the 
option you select determines how an approver’s document or batch is routed 
through the workflow.

Any user
Suppose the Any user option is selected on the Configure Workflow page. This 
means that when Sue submits a document for approval, the workflow approval 
process starts at the first steps of the workflow.

Frank

Must approve if 

the vendor is 

Northwind 

Traders.

1a.

Sue

submits a 

purchase

order.

Jill

Must approve if 

greater than 

$10,000.

1b.

Andreas

Must ALWAYS 

approve.

2a.

Sue

Must approve if 

greater than 

$20,000. 

2b.

Ann

Must ALWAYS 

approve.

3a.

John

Must approve if 

greater than 

$30,000.

3b.
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For example, assume that Sue submits a purchase order for Northwind Traders 
totalling $30,000. The system starts by evaluating the first steps to determine if 
approval is required there. Since the purchase order meets the conditions specified 
in both first steps, it is sent to Frank and Jill for approval.

When Frank and Jill approve the purchase order, it is assigned to Andreas and Sue. 
(Note that Sue will have to approve her own purchase order.) After Andreas and 
Sue approve the purchase order, Ann and John must approve it.

Only these users: approver is listed
Suppose the Only these users option is selected and Sue’s name is listed in the field. 
This means that when Sue submits a document for approval, the workflow 
approval process starts at the first steps of the workflow, as shown in the previous 
illustration.

Only these users: approver is not listed
Suppose the Only these users option is selected and Sue’s name is not listed in the 
field. This means that when Sue submits a document for approval, the workflow 
approval process starts at steps 1a and 3b.

To understand this better, review the top approval path. Because Sue is not part of 
this approval path, the system starts at the first step in the path and determines if 
approval is required there. From that point, the purchase order will move along the 
approval path as required.

Now review the bottom approval path. Because Sue is an approver in this approval 
path, the system will start at the step immediately following the step in which Sue is 
an approver. In this example, Sue is the approver at step 2b, so the system will start 
at step 3b and determine if approval is required there.

Frank

Must approve if 

the vendor is 

Northwind 

Traders.

1a.

Sue

submits a 

purchase

order.

Jill

Must approve if 

greater than 

$10,000.

1b.

Andreas

Must ALWAYS 

approve.

2a.

Sue

Must approve if 

greater than 

$20,000. 

2b.

Ann

Must ALWAYS 

approve.

3a.

John

Must approve if 

greater than 

$30,000.

3b.
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Part 3: Setup
This part of the documentation explains how to set up the Workflow system and 
create individual workflows.

• Chapter 10, “Plan the Workflow setup,” provides a checklist to help guide you 
through the setup process.

• Chapter 11, “Select workflow types,” gives a brief description of each type of 
workflow, and provides step-by-step instructions for selecting the types you 
want to use in your organization.

• Chapter 12, “Configure the Workflow calendar,” explains what the Workflow 
calendar is and how to configure it.

• Chapter 13, “Configure a workflow,” helps you create and configure a 
workflow.

• Chapter 14, “Configure a workflow step,” explains how to define a specific step 
of a workflow.

• Chapter 15, “Activate the Workflow system,” explains how to turn on the 
Workflow system in Microsoft Dynamics GP. Be sure to complete the setup 
procedures described in the previous chapters before you activate the Workflow 
system in Microsoft Dynamics GP. This way, the Workflow system is set up and 
ready for use when you activate it.

• Chapter 16, “Instruct users to set up their Workflow preferences,” contains 
instructions you can give your users. These instructions will help users specify 
how and when they want to receive alert messages and delegate their workflow 
tasks.
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Chapter 10: Plan the Workflow setup
Setting up the Workflow system is a complex process. The following information 
will help guide you through this process.

• Setup checklist
• Prepare for the setup
• Access the Workflow web site

Setup checklist

To set up the Workflow system, you’ll need to complete several tasks. The following 
table lists the tasks you’ll need to complete and the order in which you should 
complete them.

Task Complete this task 
using

1. Select workflow types.
By default, there are six types of workflows you can create. For 
example, you can create a purchase order workflow, a sales quote 
workflow, or a General Ledger batch workflow. As part of setting up 
the Workflow system, specify which types your organization will use. 

For more information, see Chapter 11, “Select workflow types.”

Workflow web site

2. Configure the Workflow calendar.
Configure the Workflow calendar to show which days are work days 
and which days are non-work days for each of your companies. The 
Workflow system will count only the work days when calculating a 
task’s due date.

For more information, see Chapter 12, “Configure the Workflow 
calendar.”

Workflow web site

3. Create workflows.
Create and configure workflows, such as a purchase order workflow or 
a General Ledger batch workflow.

For more information, see Chapter 13, “Configure a workflow.”

Workflow web site

4. Activate the Workflow system in the back office.
After you’ve completed the setup (described in the previous steps), 
turn on the Workflow system in Microsoft Dynamics GP.

For more information, see Chapter 15, “Activate the Workflow system.”

Microsoft Dynamics GP

5. Instruct users to set up their Workflow preferences.
Direct your users to the Workflow web site, where they can specify 
how they want to receive workflow alert messages and delegate tasks.

For more information, see Chapter 16, “Instruct users to set up their 
Workflow preferences.”

Workflow web site
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Prepare for the setup

The best way to prepare for setting up the Workflow system is to create diagrams 
illustrating the workflows you want to create. We recommend you draw each 
workflow using a software program such as Microsoft Office Visio®, or by simply 
using pen and paper.

Your diagrams should indicate:

• The order in which the workflow steps occur

• Who the approvers are at each step, and the conditions under which their 
approval is required

For example, your diagram may look similar to the following workflow diagram.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve is 

the vendor is 

Contoso, Ltd.

1b.

Andreas

Must approve if 

greater than 

$10,000.

2a.

Jill

Must approve if 

greater than 

$10,000.

2b.

Ann

Must approve if 

greater than 

$20,000.

3a.

Pilar

Must approve if 

greater than 

$50,000.

4.

John

Must approve if 

greater than 

$20,000.

3b.
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Access the Workflow web site

You’ll use the Microsoft Dynamics Workflow web site to complete many setup 
procedures. This site is built on Office SharePoint Server and can be accessed in 
multiple ways.

Access from your web browser
You can access the Workflow web site through your Internet Explorer browser. The 
Workflow web site’s address is configured during the Workflow installation. The 
default address is:

http://ServerName/sites/DynamicsGPWorkflow

ServerName is the name of the web server on which Workflow is installed.

Access from Microsoft Dynamics GP
You can access the Workflow web site from several windows in Microsoft Dynamics 
GP.

From this window Click this 
button

Workflow Setup
(Microsoft Dynamics GP menu > Tools > Setup > Workflow Setup)

Workflow 
Administration

Purchase Order Processing Setup
(Microsoft Dynamics GP menu > Tools > Setup > Purchasing > Purchase 
Order Processing)

Workflow Setup

Sales Order Processing Setup
(Microsoft Dynamics GP menu > Tools > Setup > Sales > Sales Order 
Processing)

Workflow Setup

General Ledger Setup
(Microsoft Dynamics GP menu > Tools > Setup > Financial > General 
Ledger)

Workflow Setup

Payables Management Setup
(Microsoft Dynamics GP menu > Tools > Setup > Purchasing > Payables)

Workflow Setup

Receivables Management Setup
(Microsoft Dynamics GP menu > Tools > Setup > Sales > Receivables)

Workflow Setup
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Chapter 11: Select workflow types
As part of setting up the Workflow system, you need to select which types of 
workflows each company will use. The following information will help you do so.

• Types of workflows
• Select the workflow types you want to use

Types of workflows

Each workflow you create will be based on a type. The type indicates the purpose of 
the workflow. By default, there are six types of workflows:

• Purchase order approval
• Sales quote approval
• Credit limit override approval
• General Ledger batch approval
• Payables Management batch approval
• Receivables Management batch approval

As part of setting up the Workflow system, you need to select which types each 
company will use. For more information about each type, see Chapter 3, “Workflow 
types.”

Select the workflow types you want to use

By default, there are six types of workflows. Use the following steps to select which 
types each company will use. 

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Click Select Workflow Types to Use. The Select Workflow Types to Use page is 
displayed.

4. Select a company from the Current Company list in the upper-right corner of 
the page. 

5. Select the check box for each type of workflow the company will use.
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6. Specify a manager (or managers) for each type of workflow. The workflow 
manager (and the Workflow administrator) will be able to create and configure 
workflows of that type.

Keep in mind, you can specify a manager for each type of workflow—even the 
types you did not select. For example, suppose you’re not ready to implement a 
sales quote workflow in your company at this time, so you don’t select the Sales 
Quote Approval check box on this page. You can, however, specify a manager 
for that type of workflow. The manager will be able to create a sales quote 
workflow. The sales quote workflow won’t be used until you:

• Select the Sales Quote Approval check box on this page.

• Select the Activate option for the sales quote workflow. For more 
information, see Activate the workflow on page 60.

• Turn on the Workflow system in Microsoft Dynamics GP. For more 
information, see Chapter 15, “Activate the Workflow system.”

7. Click Save.

Repeat these steps for each company that will use Workflow.
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Chapter 12: Configure the Workflow calendar
As part of setting up the Workflow system, you need to configure a Workflow 
calendar for each of your companies. The following sections explain what the 
Workflow calendar is and how to configure it.

• Overview of the Workflow calendar
• Configure the Workflow calendar

Overview of the Workflow calendar

The Workflow calendar shows which days are work days and which are non-work 
days. The Workflow system will count only the work days when calculating a task’s 
due date.

For example, suppose you’ve configured a purchase order workflow and have 
given Amy, the purchasing manager, three days to act on her workflow tasks. Using 
the Workflow calendar below, if Amy is assigned a purchase order on Thursday, 
she’ll have until the end of Tuesday to approve or reject the purchase order. This is 
because Saturday and Sunday are not counted toward the task’s due date.

For instructions about how to configure the Workflow calendar, see Configure the 
Workflow calendar on page 58.

Task is assigned 
to Amy.

X

X

Task is due after 
three working days.
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Configure the Workflow calendar

The Workflow calendar shows which days are work days and which are non-work 
days. The Workflow system will count only the work days when calculating a task’s 
due date. 

Use the following steps to configure the Workflow calendar.

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Click Modify Workflow Calendar. The Workflow Calendar page is displayed. 

4. Select a company from the Current Company list in the upper-right corner of 
the page. 

5. Select the check box for each day that is typically a work day in your company.

6. Review the calendar. The selected month’s work days are displayed in white. 
The non-work days are shaded. Click on a day to change its status. For example, 
if you click on a work day, it will become a non-work day and will appear 
shaded.

7. Click Save.

Repeat this procedure for each company that will use Workflow.
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Chapter 13: Configure a workflow
Creating and configuring a workflow is a complex process. The first section in this 
chapter provides the procedure you’ll need to follow to create and configure a 
workflow. The remaining sections provide details about each step in the procedure.

• Procedure for creating and configuring a workflow
• Select the type of workflow to create
• Name the workflow
• Activate the workflow
• Select originators
• Give read-only access
• Set up the workflow steps
• Indicate if documents should be approved by at least one person
• Specify an alternate final approver
• Indicate whether approvers can manually delegate tasks
• Indicate what should happen when a task is overdue
• Indicate if you want to send alert messages
• Specify how long you want to save history information

Procedure for creating and configuring a workflow
To create and configure a workflow, do the following:

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed.

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. Click New Workflow. The Select Workflow Type page is displayed.

5. Select the type of workflow to create.

6. Name the workflow.

7. Activate the workflow.

8. Select originators.

9. Give read-only access.

10. Set up the workflow steps.

11. Indicate if documents should be approved by at least one person.

12. Specify an alternate final approver.

13. Indicate whether approvers can manually delegate tasks.

14. Indicate what should happen when a task is overdue.

15. Indicate if you want to send alert messages.

16. Specify how long you want to save history information.
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Select the type of workflow to create
On the Select Workflow Type page, click the type of workflow you want to create. 
For more information about each type of workflow, see Chapter 3, “Workflow 
types.”

After you select the type of workflow you want to create, the Configure Workflow 
page is displayed. Use this page to define the properties of the workflow.

Name the workflow
Enter a unique name for the workflow. We recommend that the name include your 
company name and the type of document or batch the workflow is for. For example, 
if you’re configuring a workflow for purchase orders created in the Fabrikam 
sample company, you may want to name the workflow “Fabrikam Purchase 
Orders.”

The Copy this workflow link helps you copy an existing workflow from one company to 
another company. For more information, see Copy a workflow on page 85.

Activate the workflow
You can create multiple workflows of a specific workflow type. For example, you 
can create multiple purchase order workflows. However, only one workflow of that 
type can be used at a time. The Activate workflow option indicates which 
workflow of that type will be used.

Activate
Select the Activate workflow option to make the workflow you’re configuring the 
active workflow. If there is already an active workflow of this type, you’ll need to 
deactivate that workflow first, before activating this workflow.

Keep in mind that even though you may select the Activate workflow option, the 
workflow won’t be used until you:

• Select the corresponding workflow type on the Select Workflow Types to Use 
page. For example, if you want to use a purchase order workflow, the Purchase 
Order Approval type must be selected on the Select Workflow Types to Use 
page. For more information, see Select the workflow types you want to use on 
page 55.

• Turn on the Workflow system in Microsoft Dynamics GP. For more information, 
see Chapter 15, “Activate the Workflow system.”

Deactivate
Select the Deactivate workflow option if you’re creating a workflow that you don’t 
want to use right now. For example, suppose you’re configuring a new purchase 
order workflow. You may not want to implement this workflow in your company 
just yet, so you would select the Deactivate workflow option.

Before deactivating an existing workflow, you may want to verify that all documents 
submitted to the workflow have been processed. The Active Documents link will help you 
determine if all documents have been processed. 

For more information about deactivating a workflow, see Deactivate a workflow on 
page 90.
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Select originators

Specify who the originators are for this workflow. For example, if you’re creating a 
purchase order workflow, you must specify who can submit purchase orders for 
approval.

Any user If you select this option, any user who creates a purchase order can 
submit it for approval.

Only these users If you select this option, only the users that you specify can 
submit purchase orders for approval. Users who are not specified as originators can 
create purchase orders (provided that they have access to the Purchase Order Entry 
window in Microsoft Dynamics GP), but they will not be able to submit the 
purchase orders for approval.

Keep in mind, approvers always can submit documents and batches for approval. These 
options do not affect their ability to submit documents and batches for approval. For more 
information, see Workflow where an approver is an originator on page 46.

Give read-only access

If you’d like to give a user who is not involved in the workflow the ability to view 
documents or batches submitted for approval, enter that user’s name in the Give 
ready-only access area of the Configure Workflow page.

For example, assume that you’re configuring a purchase order workflow. Your 
warehouse manager, Ellen, is not part of the workflow; however, Ellen needs to 
view purchase orders so that she can prepare for shipments that will be arriving in 
the warehouse. To give Ellen the ability to view purchase orders submitted to the 
Workflow system, enter Ellen’s name in the Give read-only access area of the page.

Ellen will be able to view purchase orders in the Documents area of the Workflow 
web site.

Ellen will be able to view
purchase orders in the

Documents area.
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Set up the workflow steps

Click the Add Workflow Step button to add a step to this workflow. For 
instructions on how to configure a step, see Chapter 14, “Configure a workflow 
step.”

Indicate if documents should be approved by at least 
one person

There may be cases when a document does not require approval. For example, 
consider the following workflow. If Sam submits a purchase order for $100, no 
approval is needed because the purchase order does not meet any of the conditions 
specified in the workflow steps. In this scenario, the purchase order will be saved 
automatically with a status of No Approval Needed.

If you want documents to be approved by at least one person, select the Always 
require at least one approver check box. Documents that do not meet any of the 
specified conditions will be routed to the approver in the first step in the workflow. 
Using the illustration above, Sam’s purchase order for $100 will be routed to Frank 
for approval. When Frank approves the purchase order, the purchase order is given 
the status of Approved, and the workflow process is complete.

Specify an alternate final approver

The final approver is the last person in the approval path who is required to approve 
a document or batch. For example, assume that Sam submits a purchase order for 
Northwind Traders totalling $7,000. This purchase order must be approved by 
Frank and Sue. Because the purchase order is not greater than $10,000, Ann’s 
approval is not required. In this scenario, Sue is the final approver.

You may not want final approvers to “final approve” their own documents or 
batches, or those that they have edited. If so, enter the name of an alternate final 

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.
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approver in the Specify alternate final approver area of the Configure Workflow 
page.

To better understand when the alternate final approver is used, assume that Sue 
edits the $7,000 purchase order that Sam submitted. Sue increases the quantity of 
items requested so that the purchase order now totals $8,000. She then approves the 
document. Sue typically would be the final approver (because the document is not 
more than $10,000). However, because Sue edited the document, she can’t final 
approve it. The document will be sent to the alternate final approver for approval.

Indicate whether approvers can manually delegate 
tasks

To allow an approver to manually delegate a task to another approver in the 
workflow, select the Allow approver to manually assign workflow tasks to 
someone else check box.

For example, assume that Frank is reviewing a purchase order. If the Allow 
approver to manually assign workflow tasks to someone else check box has been 
selected, Frank will be able to delegate the purchase order to another approver in 
the workflow.

For more information about delegating tasks, see Delegation on page 38.

If the Allow approver 
to manually assign 
workflow tasks to 
someone else check 
box has been selected, 
Frank will be able to 
delegate this purchase 
order.
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Indicate what should happen when a task is overdue

When an approver fails to act on a task by the task’s due date, the task is considered 
overdue, or escalated. Indicate what should happen to overdue tasks by selecting 
one of the following options:

Take no action Select this option if you want the task to remain assigned to the 
current approver.

Delegate to next approver Select this option if you want the system to 
automatically assign the task to the next approver in the workflow.

Delegate to Select this option if you want the system to automatically assign the 
task to a specific user. You must enter the name of the user you want the task 
assigned to.

Have system automatically Select this option if you want the system to 
automatically act on the task. Indicate whether the system should approve or reject 
the task.

Indicate if you want to send alert messages

You can send alert messages to users when workflow tasks are assigned to them, or 
when documents or batches they’ve submitted have completed workflow approval 
processes. Review the following information to set up the default alert message 
settings.

Keep in mind, users can specify how and when they want to receive alert messages. The 
preferences they specify will override the default settings you select here. For more 
information about how users can specify their preferences, see Chapter 16, “Instruct users to 
set up their Workflow preferences.”

Microsoft Dynamics desktop alerts
Select the Send a Microsoft Dynamics desktop alert check box to send desktop 
alert messages. A desktop alert message is displayed in Microsoft Dynamics GP and 
states the task the user must complete, or provides information about the status of 
the document or batch the user submitted for approval.

Users will see desktop alert messages when they have Microsoft Dynamics GP open 
on their computers. If they do not have Microsoft Dynamics GP open, they will not 
see the alert messages.



W O R K F L O W  A D M I N I S T R A T O R ’ S  G U I D E 65

C H A P T E R  1 3    C O N F I G U R E  A  W O R K F L O W

E-mail alerts
You can send e-mail messages to users when workflow tasks are assigned to them, 
or when documents or batches they’ve submitted have completed workflow 
approval processes. You must select how often you want e-mail messages sent to 
users. Select one of the following options:

Send an immediate e-mail Select this option to send e-mail messages to users 
immediately after workflow tasks have been assigned to them, or when documents 
or batches they’ve submitted have completed workflow approval processes. 

Keep in mind, this means approvers will receive one e-mail message for each task 
assigned to them. Similarly, originators will receive one e-mail message for each 
document or batch they submitted.

Send a daily e-mail summary Select this option to send daily e-mail messages 
to users.

Specify what time you want daily e-mail messages sent. Then indicate if the 
message should list all tasks assigned to the user, or only new tasks—that is, those 
tasks assigned to the user since the last daily e-mail message was sent.

Send a weekly e-mail summary Select this option to send weekly e-mail 
messages to users.

Specify the day and time you want weekly e-mail messages sent. Then indicate if 
the message should list all tasks assigned to the user, or only new tasks—that is, 
those tasks assigned to the user since the last weekly e-mail message was sent.

Specify how long you want to save history 
information

By default, workflow history for each document and batch is saved for 365 days. 
After 365 days, the workflow history is deleted.

You may want to save workflow history for a longer or shorter amount of time. 
Specify how long you want to save workflow history in the Retain workflow 
history area of the Configure Workflow page.

For information about viewing workflow history, see View history on page 87.
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Chapter 14: Configure a workflow step
As part of configuring a workflow, you’ll need to define the specific steps in the 
workflow. The first section in this chapter provides the procedure you’ll need to 
follow to configure a workflow step. The remaining sections provide details about 
the procedure.

• Procedure for configuring a workflow step
• Name the step
• Specify where this step should occur
• Specify when approval is required at this step
• Specify what should happen when the conditions aren’t met at this step
• Select approvers
• Set a time limit
• Specify when to send carbon copies

Procedure for configuring a workflow step

To configure a workflow step, do the following:

1. From the Configure Workflow page, click the Add Workflow Step button. The 
Configure Workflow Step page is displayed.

2. Name the step.

3. Specify where this step should occur.

4. Specify when approval is required at this step.

5. Specify what should happen when the conditions aren’t met at this step.

6. Select approvers.

7. Set a time limit.

8. Specify when to send carbon copies.

Name the step

Enter a unique name for the step. We recommend that you keep the step names 
simple, such as Step 1 and Step 2, or Purchasing Manager Approval and CEO Approval. 
Keeping the step names simple will help you manage the order in which they occur.
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Specify where this step should occur

You must specify where this step should occur in the workflow.

First step in the workflow
If this step is the first step in the workflow, select This step is a first step.

Keep in mind, you can have multiple first steps. For example, review the following 
workflow illustration. Notice that steps 1a, 1b, and 1c are all first steps.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Andreas

Must approve if 

the vendor is 

Contoso, Ltd.

1b.

Ed

Must approve if 

the vendor is 

Northwind 

Traders.

1c.

Ann

Must approve if 

greater than 

$20,000.

3.

Maria

Must approve if 

greater than 

$50,000.

4.
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Subsequent step in the workflow
If this step is not a first step, select This step follows the selected step(s). Then 
select the workflow step that this step should follow.

The step you’re configuring may follow multiple steps. For example, consider the 
following workflow illustration. Notice that step 4 follows both step 3a and step 3b.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve is 

the vendor is 

Contoso, Ltd.

1b.

Andreas

Must approve if 

greater than 

$10,000.

2a.

Jill

Must approve if 

greater than 

$10,000.

2b.

Ann

Must approve if 

greater than 

$20,000.

3a.

Pilar

Must approve if 

greater than 

$50,000.

4.

John

Must approve if 

greater than 

$20,000.

3b.
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Specify when approval is required at this step

You must specify when approval is required at this step. Approval may be required 
always, or only under specific conditions.

Approval is always required
If approval is always required at this step, select the Always option.

Keep in mind, if you select Always, it doesn’t mean that this step will always occur 
in the workflow; rather, it means that any document or batch that reaches this step 
must always be approved.

To understand this better, consider the following workflow illustration. There are 
two approval paths for purchase orders: one for purchase orders for Adventure 
Works, the other for purchase orders for Contoso, Ltd. Notice that when a purchase 
order for Contoso, Ltd. reaches step 2b, Jill’s approval is always required. Purchase 
orders for Adventure Works will never reach step 2b, so Jill’s approval is not 
required in those situations.

Approval is required under specific conditions
If approval at this step is required only under specific conditions, select the Only 
option. Then specify the conditions under which approval is required.

For example, consider the previous workflow diagram. Notice that Frank’s 
approval is required only when the vendor on the purchase order is Adventure 
Works. Similarly, Ann’s approval is required only when the purchase order is 
greater than $20,000.

Frank

Must approve if 

the vendor is 

Adventure 

Works.

1a.

Sam

submits a 

purchase

order.

Sue

Must approve if 

the vendor is 

Contoso, Ltd.

1b.

Andreas

Must approve if 

greater than 

$10,000.

2a.

Jill

Must ALWAYS 

approve.

2b.

Ann

Must approve if 

greater than 

$20,000.

3a.

Pilar

Must approve if 

greater than 

$20,000.

4b.

John

Must approve if 

greater than 

$10,000.

3b.
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Here are some tips to keep in mind when entering a condition:

• The condition that you enter is case-sensitive. For example, if you’re entering a 
condition where the vendor ID is ADVENWORK001, be sure to enter 
ADVENWORK001, not advenwork001.

• If you’re entering a condition for a batch approval workflow, keep in mind that 
clearing batches don’t have batch totals. For example, a clearing batch will 
never meet a condition where the batch total is greater than $1.

• If you’re entering a condition for a batch approval workflow, you can create a 
condition based on the batch origin. For example, you can create a condition 
where the batch origin is General Entry.

The following table lists the supported batch origins for each type of workflow.

• When entering a condition that contains a percentage value, be sure the 
percentage value is less than 1. For example, assume you’re creating a credit 
limit override approval workflow. To enter a condition where the line 
markdown percentage is 50%, you should enter the percentage value as .50.

• When entering a condition that contains an amount, be sure the amount value is 
greater than 1. For example, assume you’re creating a sales quote approval 
workflow. To enter a condition where the document amount is $10,000, you 
should enter the amount value as 10000.

• If the condition you’re entering is based on the Line Markdown Amount or 
Line Markdown Percent field, you need to be particularly careful when 
entering the condition. For example, assume you’re creating a credit limit 
override approval workflow. To enter a condition where the line markdown 
percentage is greater than 50%, you should enter the following:

Where Line Markdown Percent is greater than .50
This statement ensures that the system checks for percentage values that are 
greater than 50%. However, this statement also means that the system will 
check for amount values that are greater than $0.50. To exclude amount values, 
be sure to enter the following statement.

-And-

Where Line Markdown Percent is less than and includes .99
This statement ensures that the system excludes amount values that are greater 
than $0.99.

Together, these two statements ensure that the system checks for discounts 
between 51% and 99%.

Type of workflow Supported batch origins How you must enter 
the origin name

General Ledger batch 
approval

General Entry
Clearing Entry

GL_Normal
GL_Clearing

Payables Management batch 
approval

Payables Trx Entry
Payment Entry
Computer Checks

PM_Trxent
PM_Payment
XPM_Cchecks

Receivables Management 
batch approval

Receivables Sales Entry
Receivables Cash Receipts

RM_Sales
RM_Cash
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Specify what should happen when the conditions 
aren’t met at this step

If approval at this step is required only under specific conditions, you need to 
specify what should happen when the conditions aren’t met. You can do one of two 
things:

Select the “Move to the next step” option If you select this option, the 
system will move on to the next step in the workflow and determine if approval is 
required there.

Don’t select the “Move to the next step” option If you don’t select this 
option, the workflow approval process will end.

For example, assume that Sam has submitted a purchase order totalling $200. The 
system evaluates step 1 to determine if approval is required there. Since the 
purchase order does not meet the condition specified (the amount does not fall 
within the specified range), Frank’s approval is not required.

At this point in the workflow, the system will check to see if the Move to the next 
step option is selected for step 1. 

• If the Move to the next step option is selected, the system will move on to step 2 
and determine if approval is required there. In this example, the purchase order 
does meet the condition specified at step 2, so Sue’s approval would be 
required.

• If the Move to the next step option isn’t selected, the purchase order will be 
saved with a status of No Approval Needed because it did not meet the 
condition specified at step 1.

Frank

Must approve if 

between 

$1—$100.

1.

Sam

Submits a 

purchase order 

for $200.

Sue

Must approve if 

between 

$101—$500.

2.

Ann

Must approve if 

between 

$501—$1,000.

3.

Conditio
n Not Met

If the Move to the next step option is 

selected, the system will move on to step 

2 to determine if approval is required 

there.

If the Move to the next step option is not 

selected, the purchase order will be saved 

with a status of No Approval Needed.
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Select approvers

Specify who must approve the documents or batches that reach this step in the 
workflow. You can have one approver or multiple approvers. Enter the approvers’ 
names in the Identify approvers field.

If you have one approver, that person will be responsible for approving all 
documents or batches that reach this step in the workflow.

If you have multiple approvers, you must specify how many of the approvers must 
approve the documents or batches that reach this step. Select one of the following 
options.

Take the first response
If you select this option, the action applied to the document or batch is determined 
by the first person who responds.

For example, assume Sam has submitted a purchase order for $50,000, and it is 
currently at step 3 in the workflow. If Mary is the first person to respond to the 
document, the action she takes is applied to the document. For example, if she 
approves it, the document is sent to Ann for approval. If Mary rejects the document, 
it is given the status of Rejected and the workflow process is complete.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Bill, Jo, Mary

Must approve if 

greater than 

$10,000.

3.

Ann

Must approve if 

greater than 

$20,000.

4.
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Majority must approve
If you select this option, a majority of the approvers must approve the document or 
batch in order for it to continue down the workflow approval path.

For example, consider the workflow previously illustrated. Assume that Sam has 
submitted a purchase order for $50,000 and it is currently at step 3 in the workflow. 

• If Bill and Jo are the first two approvers to respond—and they both approve the 
document—the document is sent to Ann for approval. Because a majority is 
reached, the system does not wait for Mary to respond.

• If Bill and Jo are the first two approvers to respond—and they both reject the 
document—the document is given the status of Rejected and the workflow 
process is complete. Because a majority is reached, the system does not wait for 
Mary to respond.

• If Bill approves the document and then Jo requests a change, the document is 
given the status of Pending Changes. Because a change is requested, the 
document is immediately sent back to the originator. The system does not wait 
for Mary to respond.

Keep in mind, if a workflow step has an even number of approvers, a majority must 
still approve the document or batch in order for it to continue down the workflow 
approval path. For example, suppose step 3 has four approvers (Bill, Jo, Mary, and 
Chris). Three approvers must approve the document in order for it to continue 
down the approval path. If two approvers approve the document, and two reject it, 
the document is given the Rejected status because a majority was not reached.

All must approve
If you select this option, all of the approvers must approve the document or batch in 
order for it to continue down the workflow approval path. 

For example, consider the workflow previously illustrated. Assume that Sam has 
submitted a purchase order for $50,000 and it is currently at step 3 in the workflow. 
If all of the approvers (Bill, Jo, and Mary) approve the document, it is sent to Ann 
for approval. If one person rejects the document, it is given the status of Rejected 
and the workflow process is complete. If one person requests a change to the 
document, it is sent to Sam with a status of Pending Changes.
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Set a time limit

A task is a document or batch assigned to an approver. Specify how many days the 
approver has to respond to the task—that is, approve or reject it. The number of 
days you enter will be used to calculate the task’s due date.

For detailed information about how a task’s due date is calculated, see Overview of the 
Workflow calendar on page 57.

If an approver fails to respond by the due date, the task is considered overdue, or 
escalated. The task will then be handled according to the option you selected in the 
When a step is overdue area of the Configure Workflow page. For more 
information, see Indicate what should happen when a task is overdue on page 64.

Specify when to send carbon copies

If you selected to send alert messages (as described in Indicate if you want to send alert 
messages on page 64), alert messages will be sent to users when tasks are assigned to 
them, or when documents or batches they submitted have completed workflow 
approval processes.

You also can send alert messages in the following situations. Alert messages that are 
sent in these situations are referred to as carbon copies.

Approved Select this check box to send an alert message when the approvers at 
this step approve a document or batch. Then specify who should receive the alert 
message.

Assigned Select this check box to send an alert message when a document or 
batch is assigned to the approvers at this step. Then specify who should receive the 
alert message.

Change requested Select this check box to send an alert message when an 
approver at this step requests a change to a document or batch. Then specify who 
should receive the alert message.

Rejected Select this check box to send an alert message when the approvers at 
this step reject a document or batch. Then specify who should receive the alert 
message.

Delegated Select this check box to send an alert message when an approver at 
this step delegates a document or batch to another user. Then specify who should 
receive the alert message.

Escalated Select this check box to send an alert message when the approvers at 
this step fail to act on the document or batch. (The document or batch is considered 
escalated.) Then specify who should receive the alert message.
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Chapter 15: Activate the Workflow system
To turn on the Workflow system in Microsoft Dynamics GP, complete the following 
procedures:

• Specify which companies will use Workflow
• Verify URLs

Specify which companies will use Workflow

The Workflow system is activated on a per-company basis. Complete the following 
steps in Microsoft Dynamics GP to specify which companies will use Workflow.

1. Open the Workflow Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Workflow Setup

2. Select the Activate Workflow for <Company Name> check box.

Selecting this option will activate the Workflow system for the company you are 
currently logged on to.

3. Click OK.

4. In order for the activation to take effect, restart Microsoft Dynamics GP.

To activate Workflow for another company, log on to the specific company and 
repeat the steps above.
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Verify URLs

The Workflow Setup window contains information about your Workflow 
installation. This window has two fields:

• The Microsoft Dynamics Workflow location field contains the URL to the 
Workflow web service.

• The Office Server location field contains the URL to the Workflow web site. 

The Workflow installation program should have entered the appropriate URLs in 
these fields. To verify that these URLs are correct, click the Workflow 
Administration button. Your browser should open, displaying the Workflow web 
site. If the Workflow web site is not displayed, use the following steps to enter the 
correct URLs.

1. Open the Workflow Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Workflow Setup

2. In the Microsoft Dynamics Workflow location field, enter the URL of the 
Workflow web service. The default URL is:

http://ServerName/_vti_bin/WorkflowService.asmx

ServerName is the name of the web server on which Workflow is installed.

3. In the Office Server location field, enter the URL of the Workflow web site. The 
default URL is:

http://ServerName/sites/DynamicsGPWorkflow

ServerName is the name of the web server on which Workflow is installed.

4. Click Workflow Administration to verify that the URLs are correct. Your 
browser should open, displaying the Workflow web site.

5. Go back to the Workflow Setup window and click OK to save your changes.
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Chapter 16: Instruct users to set up their 
Workflow preferences
After you’ve activated the Workflow system in Microsoft Dynamics GP, instruct 
your users to set up their Workflow preferences. Users can specify how and when 
they want to receive alert messages, and they can delegate their workflow tasks to 
other users.

• Configuring alert message settings
• Delegate tasks

Configuring alert message settings

As part of creating a workflow, you specified how alert messages should be sent to 
users. Users can override the default settings you selected and specify their own 
preferences.

Have your users complete the following steps to specify how and when they want 
to receive alert messages.

1. Go to the Workflow web site.

2. Click My Alerts on the Quick Launch. The Workflow Alerts page is displayed.

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. Click a workflow type to configure your alert settings for that type. The 
Workflow User Alerts page is displayed. 

5. Select the Receive a Microsoft Dynamics Desktop Alert check box to receive 
desktop alert messages when tasks are assigned to you, or when documents or 
batches you’ve submitted have completed workflow approval processes.

6. To receive e-mail alert messages, select one of the following options:

Receive an immediate e-mail Select this option to receive e-mail 
messages immediately after workflow tasks have been assigned to you, or 
when documents or batches you’ve submitted have completed workflow 
approval processes. 

Keep in mind, this means you will receive one e-mail message for each task 
assigned to you, and one e-mail message for each document or batch you 
submitted.
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Receive a daily e-mail summary Select this option to receive a daily e-
mail message.

Specify what time you want daily e-mail messages sent to you. Then indicate if 
the message should list all tasks assigned to you, or only new tasks—that is, 
those tasks assigned to you since the last daily e-mail message was sent.

Send a weekly e-mail summary Select this option to receive a weekly e-
mail message.

Specify the day and time you want weekly e-mail messages sent to you. Then 
indicate if the message should list all tasks assigned to you, or only new tasks—
that is, those tasks assigned to you since the last weekly e-mail message was 
sent.

7. Click OK.

Repeat this procedure for each company you belong to.

Delegate tasks

Approvers can delegate, or reassign, their tasks to other approvers. For example, if 
Frank will be out of the office for a period of time, he can delegate his tasks to 
another approver in the workflow, such as Sue or Ann.

If users will be out of the office for a period of time, or will be unavailable to 
respond to tasks, have them delegate their tasks using the following steps.

1. Go to the Workflow web site.

2. Click My Delegation on the Quick Launch. The Workflow User Delegation 
page is displayed.

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. If you want to delegate all of your tasks, select the Select all my workflows 
check box.

If you want to delegate only the tasks for a particular type of workflow, select 
the workflow type.

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.
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5. For each workflow type that you selected, specify who you want your tasks 
delegated to.

6. For each workflow type that you selected, specify when your tasks should be 
delegated by entering a starting and ending date.

7. Click OK.

Repeat this procedure for each company you belong to.
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Part 4: Maintenance and 
troubleshooting
This part of the documentation contains maintenance procedures you may need to 
perform, such as modifying or deactivating a workflow. 

• Chapter 17, “Copy, modify, or delete a workflow,” explains how to copy a 
workflow from one company to another, how to modify a workflow, and how 
to delete workflows you’re no longer using.

• Chapter 18, “View documents and history,” explains how to view documents 
and their workflow history.

• Chapter 19, “Deactivate a workflow,” explains how to deactivate a workflow 
and turn off the Workflow system in Microsoft Dynamics GP.

• Chapter 20, “Change the Workflow web site URL,” explains how to change the 
URL of the Workflow web site. You’ll need to complete the procedures in this 
chapter after implementing Secure Socket Layer (SSL) or adding another 
Workflow web server to your configuration.

• Chapter 21, “Troubleshooting,” provides information to help you troubleshoot 
issues with the Workflow system.
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Chapter 17: Copy, modify, or delete a workflow
The following sections explain how to copy, modify, and delete a workflow.

• Copy a workflow
• Modify a workflow
• Delete a workflow

Copy a workflow

An easy way to create a new workflow is to copy an existing one and modify it, as 
necessary.

Use the following steps to copy an existing workflow.

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. Click the workflow you want to copy. The Configure Workflow page is 
displayed.

5. In the Name the workflow area of the page, click Copy this workflow. The 
Copy Workflow page is displayed.

6. Enter a unique name for the workflow. 

We recommend that the name include your company name and the type of 
document or batch the workflow is for. For example, if you’re configuring a 
workflow for purchase orders created in the Fabrikam sample company, you 
may want to name the workflow “Fabrikam Purchase Orders.”

7. Select the company this workflow is for. 

You can copy this workflow to the company you are currently working in, or 
you can copy the workflow to another company.

8. Click Save.

Modify a workflow

Use the following steps to modify a workflow.

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Select a company from the Current Company list in the upper-right corner of 
the page. 
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4. Click the workflow you want to modify. The Configure Workflow page is 
displayed.

5. Modify the workflow, as necessary. For more information about each of the 
options on this page, see Chapter 13, “Configure a workflow.”

6. Click Save.

Delete a workflow

To delete a workflow you’re no longer using, use the following steps.

You must deactivate a workflow before you can delete it. For more information, see Chapter 
19, “Deactivate a workflow.”

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. Click the Delete link for the workflow you want to delete.
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Chapter 18: View documents and history
The following information explains how to view documents and batches that have 
been submitted to the Workflow system, and their workflow history.

• View documents and batches
• View history

View documents and batches

You can view documents and batches that have been submitted to the Workflow 
system in several areas of Microsoft Dynamics GP. For example, you can view a 
submitted purchase order in the Purchase Order Entry window or in purchase 
order lists.

You can also view documents and batches that have been submitted to the 
Workflow system on the Workflow web site. Use the following steps to view 
submitted documents and batches on the Workflow web site. 

1. Go to the Workflow web site.

2. Click Documents on the Quick Launch. The Workflow Documents page is 
displayed.

3. Click a workflow type. 

The documents or batches submitted to that type of workflow are listed. To 
filter the documents listed on this page, select a view from the View menu.

• If you select the My Documents view, the documents or batches that you 
submitted—and that are pending approval—are listed.

• If you select the All Items view, all documents or batches submitted to this 
workflow are listed, regardless of who submitted them or their approval 
status.

• If you select the In Progress view, all documents or batches pending 
approval are listed, regardless of who submitted them.

4. Click a document or batch to view details about it.

View history

You can view the workflow history of a document or batch by looking at the 
workflow history pane in certain Microsoft Dynamics GP windows. For example, to 
view the workflow history of a purchase order, open the Purchase Order Entry 
window in Microsoft Dynamics GP and view the workflow history pane.

You can also view the workflow history of a document or batch by using the 
Workflow web site. Use the following steps to view workflow history information 
on the Workflow web site.
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1. Go to the Workflow web site.

2. Click Documents on the Quick Launch. The Workflow Documents page is 
displayed.

3. Click a workflow type. The documents or batches that you submitted—and that 
are pending approval—are listed. 

4. From the View menu, click All Items. All documents or batches submitted to 
this workflow are listed, regardless of who submitted them or their approval 
status.

5. From the View menu, click Modify this View. The Edit View: <Workflow Type> 
page is displayed.

6. In the Columns area of the page, select the Approval Status check box.

7. Click OK. 

8. An Approval Status column now appears on your page. To view the workflow 
history of a specific document or batch, click the status of that document or 
batch.

The Workflow Status: Approval Status page is displayed. Workflow history 
information is shown at the bottom of the page.
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Chapter 19: Deactivate a workflow
The following sections explain how to turn off a workflow, a workflow type, or the 
entire Workflow system.

• About deactivating
• Deactivate a workflow
• Deactivate a workflow type
• Deactivate the Workflow system

About deactivating

Deactivating refers to turning off a workflow, a workflow type, or the Workflow 
system.

Before you deactivate a workflow, a workflow type, or the entire Workflow system, you may 
want to process the documents that are awaiting approval. To view a list of active 
documents, see View documents and batches on page 87.

Deactivate a workflow
When you deactivate a workflow, the following occurs:

• Documents or batches that are awaiting approval are given the status of 
Workflow Deactivated.

For example, suppose you deactivate the purchase order approval workflow. 
Purchase orders that are awaiting approval are given the Workflow Deactivated 
status. These purchase orders no longer require approval and can be processed 
according to your company’s business practices. For example, you can print the 
purchase orders and receive shipments.

• Any active tasks associated with the workflow are removed.

• The message bar and workflow history pane that appeared in the associated 
entry window in Microsoft Dynamics GP are removed. For example, the 
message bar and workflow history pane that appeared in the Purchase Order 
Entry window would be removed.

Deactivate a workflow type
When you deactivate a workflow type, the active workflow of that type is 
automatically deactivated.

Deactivate the Workflow system
When you deactivate the Workflow system for a company in Microsoft Dynamics 
GP, all workflow types are deactivated for that company. (As a result, all active 
workflows are deactivated for that company.)
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Deactivate a workflow

Use the following steps to deactivate a workflow.

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Select a company from the Current Company list in the upper-right corner of 
the page. 

4. Click the workflow you want to deactivate. The Configure Workflow page is 
displayed.

5. In the Activate the workflow area of the page, select the Deactivate workflow 
option.

6. A message appears, indicating that all in-progress workflows will end. Click 
OK to continue.

7. Click Save.

Deactivate a workflow type

Use the following steps to deactivate a workflow type. When you deactivate a 
workflow type, the active workflow of that type is automatically deactivated, as 
well.

1. Go to the Workflow web site.

2. Click Administration on the Quick Launch. The Workflow List page is 
displayed. 

3. Click Select Workflow Types to Use. The Select Workflow Types to Use page is 
displayed.

4. Select a company from the Current Company list in the upper-right corner of 
the page. 

5. Clear the check box for each workflow type you no longer want to use.

6. A message appears, indicating that active tasks for the associated workflow will 
be removed. Click OK to continue.

7. Click Save.
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Deactivate the Workflow system

The Workflow system is activated (and deactivated) on a per-company basis. 
Complete the following steps in Microsoft Dynamics GP to deactivate the Workflow 
system for a specific company.

When you deactivate the Workflow system, all workflow types are deactivated for 
that company. (As a result, all active workflows are deactivated for that company, as 
well.)

1. Open the Workflow Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Workflow Setup

2. Clear the Activate Workflow for <Company Name> check box.

Clearing this check box will deactivate the Workflow system for the company 
you are currently logged on to.

3. Click OK. 

4. Reconcile the modules that were using Workflow. For example, if you were 
using the purchase order approval workflow, reconcile the Purchase Order 
Processing module. 

For information about reconciling a module, see the documentation for that 
module.

To deactivate Workflow for another company, log on to the specific company and 
repeat the steps above.
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Chapter 20: Change the Workflow web site URL
The following information explains how to change the URL of the Workflow web 
site.

• Why you might need to change the URL
• Change the URL of the Workflow web site

Why you might need to change the URL

After you’ve installed Workflow, you may decide to modify your Workflow 
deployment configuration. For example, you may decide to:

• Implement Secure Sockets Layer (SSL) for the Workflow web site.

• Add another Workflow web server to create a load balanced server farm.

If you modify your Workflow deployment configuration in either of these ways, the 
URL of the Workflow web site must be changed. Complete the procedures in Change 
the URL of the Workflow web site to change the URL.

Change the URL of the Workflow web site

If you’ve modified your Workflow deployment configuration (as described in Why 
you might need to change the URL), complete the following procedures to change the 
URL of the Workflow web site.

For example, assume you’ve implemented SSL by installing a certificate and a 
private key on your web server. This means you must change http to https in the 
Workflow web site URL

To change the URL in the Office SharePoint Server 
databases:
1. On the Workflow web server, double-click the following file:

Microsoft.Dynamics.Workflow.SiteConfigurator.exe

This file is typically located at \Program Files\Microsoft Dynamics\Workflow.

2. The Workflow Site Configurator window is displayed. Enter the new URL of 
the Workflow web site.

3. Click Save. The new URL will be saved to the Office SharePoint Server 
databases.

To change the URL in SharePoint Central Administration:
1. Open SharePoint Central Administration.

Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Operations tab.

3. Under the Global Configuration heading, click Alternate access mappings. 
The Alternate Access Mappings page is displayed.
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4. Click Edit Public URLs. The Edit Public Zone URLs page is displayed.

5. In the Alternate Access Mapping Collection field, click the down arrow to 
select the Workflow web application.

6. Enter the new URL of the Workflow web site. 

7. Click Save.

To change the URL in the Workflow Setup window:
1. Open the Workflow Setup window in Microsoft Dynamics GP.

Microsoft Dynamics GP menu > Tools > Setup > Workflow Setup

2. In the Microsoft Dynamics Workflow location field, enter the new URL of the 
Workflow web service.

3. In the Office Server location field, enter the new URL of the Workflow web 
site. 

4. Click Workflow Administration. Your web browser should open, displaying 
the Workflow web site.

5. Go back to the Workflow Setup window and click OK to save your changes.

If you repair your Workflow installation (by clicking the Repair option in Add or Remove 
Programs), the Workflow web site URL will be reset to the original URL. You’ll need to 
complete the procedures in this section again.



W O R K F L O W  A D M I N I S T R A T O R ’ S  G U I D E 95

Chapter 21: Troubleshooting
The following sections provide information to help you troubleshoot Workflow 
issues.

• View the Dynamics event log
• Turn on tracing
• Monitor performance
• Resubmit documents or batches with the Submitted status

View the Dynamics event log

If an error is encountered in the Workflow system, open the Dynamics event log on 
the Workflow web server to view detailed information about the error. Use the 
following steps to view the Dynamics event log.

1. Open the Event Viewer console.
Start > All Programs > Administrative Tools > Event Viewer

2. In the left pane of the console, click Dynamics. Events are listed in the right 
pane of the console.

3. Double-click an error to view details about the error.

Turn on tracing

To troubleshoot issues related to the Workflow system, you can add diagnostic 
tracing switches to the web.config and owstimer.exe.config files. The following 
procedures will help you add the switches, turn on the switches, and specify which 
file the trace statements will be logged to.

Before modifying the web.config and owstimer.exe.config files, we recommend you make 
backups of them.

Complete the following procedures on the Workflow web server.

To add tracing switches:
1. Open the web.config and owstimer.exe.config files. 

By default, the web.config file is located at 
\Inetpub\wwwroot\wss\VirtualDirectories\PortNumber, where PortNumber is 
the port the Workflow web site is running on.

By default, the owstimer.exe.config file is located at \Program Files\Common 
Files\Microsoft Shared\web server extensions\12\BIN.
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2. Within the <configuration> element, find the <configSections> element. Add 
the following code after the <configSections> element.

<system.diagnostics>
<switches>
<add name="System.Workflow LogToTraceListeners" value="0"/>
<add name="System.Workflow.Runtime.Hosting" value="Off"/>
<add name="System.Workflow.Runtime" value="Off"/>
<add name="System.Workflow.Runtime.Tracking" value="Off"/>
<add name="System.Workflow.Activities" value="Off"/>
<add name="ApplicationTraceSwitch" value="0" />
</switches>
<trace autoflush="false" indentsize="4">
<listeners>
<add name="myListener" type="System.Diagnostics.TextWriterTraceListener" 
initializeData="<some location>\Trace.log" />
</listeners>
</trace>
</system.diagnostics>

3. Save your changes.

To turn on the tracing switches:
1. In the web.config and owstimer.exe.config files, find the following line:

<add name="System.Workflow LogToTraceListeners" value="0"/>

To turn on this switch, change the value to 1.

2. Find the following lines:

<add name="System.Workflow.Runtime.Hosting" value="Off"/>
<add name="System.Workflow.Runtime" value="Off"/>
<add name="System.Workflow.Runtime.Tracking" value="Off"/>
<add name="System.Workflow.Activities" value="Off"/>

To turn on these switches, change the values to one of the following:

Value Description

All For information about these values, see the “Workflow 
Configuration Files” article on MSDN. (Go to http://
msdn2.microsoft.com and search for Workflow 
Configuration Files.)

Critical

Error

Warning

Information

Verbose

http://msdn2.microsoft.com
http://msdn2.microsoft.com
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3. Find the following line:

<add name="ApplicationTraceSwitch" value="0" />

To turn on this switch, change the value to one of the following:

4. Save your changes.

When you are done tracing, be sure to turn off the tracing switches.

To specify where trace statements will be logged:
1. In the web.config and owstimer.exe.config files, find the following line:

<add name="myListener" type="System.Diagnostics.TextWriterTraceListener" 
initializeData="<some location>\Trace.log" />

Replace <some location> with a location on the server’s hard drive.

2. Determine which user accounts are acting as the identities of the SharePoint 
Central Administration and Workflow application pools. Give these user 
accounts Write access to the location you specified in step 1.

3. Save your changes.

Monitor performance

If you are experiencing performance issues with the Workflow system, you can log 
performance statistics to the Windows performance monitor. To do so, you must 
first turn on the performance monitoring switches, found in the web.config and 
owstimer.exe.config files. Then you can view Workflow performance statistics in the 
performance monitor.

Before modifying the web.config and owstimer.exe.config files, we recommend you make 
backups of them.

Complete the following procedures on the Workflow web server.

To turn on the performance monitoring switches:
1. Open the web.config and owstimer.exe.config files. 

By default, the web.config file is located at 
\Inetpub\wwwroot\wss\VirtualDirectories\PortNumber, where PortNumber is 
the port the Workflow web site is running on.

By default, the owstimer.exe.config file is located at \Program Files\Common 
Files\Microsoft Shared\web server extensions\12\BIN.

Value Description

1 Error

2 Warning

3 Info

4 Verbose
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2. Find the following line:

<add key="PerformanceMonitoring" value="OFF">

3. Change the OFF value to ON.

When you are done monitoring performance, be sure to set the value back to OFF.

4. Save your changes.

To view Workflow performance statistics:
1. Open the Windows Performance monitor.

Start > All Programs > Administrative Tools > Performance

2. In the tree view, click System Monitor.

3. In the details pane, click the Add icon button. The Add Counters window is 
displayed.

4. From the Performance object list, select Dynamics WF Operations. 

5. Select the counters you want to view. Click Add.

6. From the Performance object list, select Dynamics WF SP Operations. 

7. Select the counters you want to view. Click Add.

8. Click Close to close the Add Counters window. You can now view the 
performance of the Workflow system in the details pane.

Resubmit documents or batches with the Submitted 
status

When a document or batch is submitted for approval, it is immediately given the 
Submitted status. The Workflow system then evaluates the steps in the workflow to 
determine if approval is required. 

• If approval is required, the document or batch is given the Pending Approval 
status.

• If approval is not required, the document or batch is given the No Approval 
Needed status.

If the document or batch has the Submitted status for a period of time, it may 
indicate an issue with the Workflow system. We recommend that you reconcile the 
associated module, and then resubmit the document or batch for approval.

For example, if a purchase order has the Submitted status for a period of time, we 
recommend that you reconcile the Purchase Order Processing module, and then 
resubmit the purchase order for approval.

For information about reconciling a module, see the documentation for that 
module.



P
A

R
T

 5
: R

E
P

O
R

T
S



100 W O R K F L O W  A D M I N I S T R A T O R ’ S  G U I D E

Part 5: Reports
There are five types of reports you can use to monitor the Workflow system. The 
following information describes the reports and explains how to generate them.

• Chapter 22, “Report descriptions,” shows you what information is displayed on 
each report.

• Chapter 23, “Generate reports,” provides step-by-step instructions for 
generating each Workflow report.
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Chapter 22: Report descriptions
There are five reports you can use to monitor the Workflow system. The following 
sections describe the reports and explain when you may want to use them.

• Completed Tasks by Approvers report
• Completed Tasks by Workflow Step report
• Completed Documents report
• Active Tasks report
• Task Summary report

Completed Tasks by Approvers report

The Completed Tasks by Approvers report shows how many days it took a specific 
approver to complete his or her tasks. This report helps you identify approvers who 
may be slowing down a workflow approval process.

To generate this report, see Generate the Completed Tasks by Approvers report on 
page 105.
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Completed Tasks by Workflow Step report

The Completed Tasks by Workflow Step report shows how many days it took to 
complete a specific workflow step. This report helps you identify specific steps that 
may be slowing down a workflow approval process.

To generate this report, see Generate the Completed Tasks by Workflow Step report on 
page 105.

Completed Documents report

The Completed Documents report displays a list of documents and batches that 
have completed their workflows. The report shows how many days it took to 
complete the workflow for each document and batch.

To generate this report, see Generate the Completed Documents report on page 106.
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Active Tasks report

The Active Tasks report displays a list of active tasks and the approvers they are 
assigned to. This report helps you identify approvers who may have several active 
tasks assigned to them.

To generate this report, see Generate the Active Tasks report on page 107.

Task Summary report

The Task Summary report displays task information for a specific workflow step. 
For example, you can view the number of tasks that are active, completed, and 
escalated for a specific step.

To generate this report, see Generate the Task Summary report on page 107.
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Chapter 23: Generate reports
The following sections explain how to generate the Workflow reports:

• Generate the Completed Tasks by Approvers report
• Generate the Completed Tasks by Workflow Step report
• Generate the Completed Documents report
• Generate the Active Tasks report
• Generate the Task Summary report

Generate the Completed Tasks by Approvers report

Use the following steps to generate the Completed Tasks by Approvers report.

1. Go to the Workflow web site.

2. Click Reports on the Quick Launch. The Workflow Reports page is displayed.

3. From the Current Company list in the upper-right corner of the page, select the 
company you want to generate a report for.

4. Click Completed Tasks by Approvers Report. The Completed Tasks by 
Approvers Report page is displayed.

5. Select the company you want to generate a report for.

6. Select a workflow type.

7. Select an approver.

8. Enter a range of task due dates to limit the number of tasks that are listed on the 
report.

9. Click Process Report.

10. The File Download dialog box appears. You can display the report or save it to a 
specified location.

• To display the report, click Open. The report is displayed in Microsoft 
Office Excel®.

• To save the report, click Save. Specify where you want to save the report. 
The report is saved as an .xml file.

Generate the Completed Tasks by Workflow Step 
report

Use the following steps to generate the Completed Tasks by Workflow Step report.

1. Go to the Workflow web site.

2. Click Reports on the Quick Launch. The Workflow Reports page is displayed.

3. From the Current Company list in the upper-right corner of the page, select the 
company you want to generate a report for.
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4. Click Completed Tasks by Workflow Step Report. The Completed Tasks by 
Workflow Step Report page is displayed.

5. Select the company you want to generate a report for.

6. Select a workflow type.

7. Select a workflow step.

The list displays the names of workflow steps. The name of the workflow the step belongs 
to is in parentheses.

8. Enter a range of task due dates to limit the number of tasks that are listed on the 
report.

9. Click Process Report.

10. The File Download dialog box appears. You can display the report or save it to a 
specified location.

• To display the report, click Open. The report is displayed in Excel.

• To save the report, click Save. Specify where you want to save the report. 
The report is saved as an .xml file.

Generate the Completed Documents report

Use the following steps to generate the Completed Documents report.

1. Go to the Workflow web site.

2. Click Reports on the Quick Launch. The Workflow Reports page is displayed.

3. From the Current Company list in the upper-right corner of the page, select the 
company you want to generate a report for.

4. Click Completed Documents Report. The Completed Documents Report page 
is displayed.

5. Select the company you want to generate a report for.

6. Select a workflow type.

7. Enter a range of dates to limit the number of documents that are listed on the 
report.

8. Click Process Report.

9. The File Download dialog box appears. You can display the report or save it to a 
specified location.

• To display the report, click Open. The report is displayed in Excel.

• To save the report, click Save. Specify where you want to save the report. 
The report is saved as an .xml file.
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Generate the Active Tasks report

Use the following steps to generate the Active Tasks report.

1. Go to the Workflow web site.

2. Click Reports on the Quick Launch. The Workflow Reports page is displayed.

3. From the Current Company list in the upper-right corner of the page, select the 
company you want to generate a report for.

4. Click Active Tasks Report. The Active Tasks Report page is displayed.

5. Select the company you want to generate a report for.

6. Select a workflow type.

7. Select an approver.

8. Enter a range of task due dates to limit the number of tasks that are listed on the 
report.

9. Click Process Report.

10. The File Download dialog box appears. You can display the report or save it to a 
specified location.

• To display the report, click Open. The report is displayed in Excel.

• To save the report, click Save. Specify where you want to save the report. 
The report is saved as an .xml file.

Generate the Task Summary report

Use the following steps to generate the Task Summary report.

1. Go to the Workflow web site.

2. Click Reports on the Quick Launch. The Workflow Reports page is displayed.

3. From the Current Company list in the upper-right corner of the page, select the 
company you want to generate a report for.

4. Click Task Summary Report. The Task Summary Report page is displayed.

5. Select the company you want to generate a report for.

6. Select a workflow type.

7. Select a workflow step.

The list displays the names of workflow steps. The name of the workflow the step belongs 
to is in parentheses.

8. Select an approver.
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9. Enter a range of task due dates to limit the number of tasks that are listed on the 
report.

10. Click Process Report.

11. The File Download dialog box appears. You can display the report or save it to a 
specified location.

• To display the report, click Open. The report is displayed in Excel.

• To save the report, click Save. Specify where you want to save the report. 
The report is saved as an .xml file.
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